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Ваш Mac mini разработан таким образом,  
чтобы вы могли быстро настроить его и сразу же  
приступить к использованию.
Если вы никогда не работали с Mac mini или не знакомы с компьютерами 
Macintosh, прочитайте этот раздел для получения инструкций по началу 
работы. Если вы опытный пользователь и знаете достаточно для начала работы, 
обратитесь к главе 2 «Знакомство с Mac mini», чтобы узнать о новых особенностях 
этой модели Mac mini.

Предупреждение: Перед тем, как подключить компьютер к электрической сети, 
прочтите все инструкции по настройке и безопасности (см. на странице 69).

Начало работы 1



Комплект поставки
В комплект поставки входит следующее:

Перед началом работы с Вашим Mac mini снимите защитную пленку с компьютера 
и адаптера питания.

10 Глава 1 Начало работы

MENU

Адаптер питания

Пульт Apple Remote

Шнур питания

Адаптер DVI-to-VGA
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Подготовка к работе вашего Mac mini
Не следует запускать и использовать компьютер в перевернутом состоянии. 
Другие же положения (обычное или на боку) допускаются для нормальной 
эксплуатации. Используйте только адаптер питания из комплекта поставки,  
другие адаптеры не будут работать с вашим Mac mini.  
Следующие страницы познакомят вас с процессом подготовки к работе.

Шаг 1: Вставьте шнур питания в адаптер питания до конца. 
Подсоедините шнур от адаптера питания к компьютеру. 
Подсоедините адаптер питания к заземленной розетке.



Шаг 2: Для получения доступа к сети Интернет подключите  
к компьютеру кабель Ethernet.

Для установки коммутируемого соединения требуется внешний модем Apple USB 
Modem, который можно приобрести у официального дилера Apple. Подключите 
модем Apple USB Modem к USB порту компьютера Mac mini, затем подключите 
телефонный провод (не прилагается) к модему и телефонной розетке.

Если вы присоединяетесь к беспроводной сети или настраиваете ее, обратитесь  
к приложению C, «Подключение к Интернет», на странице 79.

12 Глава 1 Начало работы
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Шаг 3: Подсоедините USB-кабель от клавиатуры и мыши.

Вместе с Mac mini не поставляется ни клавиатура, ни мышь. С вашим компьютером 
можно использовать практически любую клавиатуру и мышь с разъемом USB (d). 
Если на клавиатуре есть порт USB, то к этому порту можно подсоединить мышь. 
Если такого порта нет, мышь можно подсоединить к порту USB (d) с обратной 
стороны системного блока.



Если вы используете клавиатуру USB, разработанную не для Mac OS,  
на ней отсутствуют клавиши Command (x) и Option. Клавиша Windows  
(с изображением логотипа Windows) является эквивалентом клавиши  
Command (x), а клавиша Alt заменяет клавишу Option.

Изменить назначение этих клавиш можно в Apple (K) > System Preferences > 
Keyboard & Mouse > Keyboard > Modifier Keys.

Использование мыши или клавиатуры с разъемом USB от любого другого 
производителя может потребовать установки драйверов программного 
обеспечения. Посетите сайт производителя и скачайте драйверы  
последней версии.

Чтобы использовать беспроводную клавиатуру Apple Wireless Keyboard  
и/или мышь Apple Wireless Mouse с вашим Mac mini, следуйте инструкциям  
в инструкции по эксплуатации, прилагающимся к клавиатуре и мыши.

14 Глава 1 Начало работы
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Шаг 4: Подсоедините кабель DVI от монитора к порту видеовыхода. 
Подсоедините кабель DVI к порту видеовыхода (£) на обратной стороне  
Mac mini. Для подсоединения монитора VGA используйте переходник компании 
Apple от разъема DVI к разъему VGA, который поставляется вместе  
с компьютером. Для получения более подробной информации  
по подсоединению монитора см. указания в главе 2, «Знакомство с Mac mini».

Замечание: Монитор не входит в комплект поставки Mac mini.

Предупреждение: Ничего не ставьте на Mac mini. Объекты, поставленные  
на Mac mini, могут создать помехи оптическому дисководу или радиосигналу 
AirPort или Bluetooth®.



Шаг 5: Нажмите кнопку Power (®) на обратной стороне Mac mini, 
чтобы включить его.

Следующие шаги
При первом включении Mac mini запустится программа Setup Assistant.  
Эта программа поможет вам настроить учетную запись пользователя на вашем 
компьютере и ввести данные для настройки Интернет и электронной почты.  
Если у вас уже есть компьютер Mac, программа Setup Assistant поможет  
вам автоматически перенести файлы, программы и другую информацию  
с вашего старого компьютера на ваш новый Mac mini.

16 Глава 1 Начало работы
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Перенос информации на Mac mini
Программа Setup Assistant поможет вам легко скопировать ваши настройки, 
файлы, папки со старого Mac. Он покажет как подключить старый Mac  
к новому, чтобы перенести ваши сетевые настройки, учетные записи, документы, 
фотографии, программы и другие материалы. Для быстрой передачи файлов 
на новый компьютер Setup Assistant использует соединение FireWire — просто 
следуйте инструкциям на экране.

Чтобы перенести информацию убедитесь, что:
• У вас есть стандартный кабель FireWire.

• На другом компьютере Mac установлена операционная система  
 Mac OS X 10.1 или выше.

• Другой компьютер Mac оснащен портом FireWire и поддерживает режим  
 FireWire Target Disk Mode.

Setup Assistant поможет вам осуществить перенос информации.  
Перенос информации на Mac mini не влияет на содержимое вашего старого 
компьютера Mac. С помощью Setup Assistant вы можете перенести:

• Учетные записи пользователей, включая настройки и электронную почту.

• Сетевые настройки.

• Вашу папку Applications (Программы).

• Файлы и папки с основного жесткого диска и других жестких дисков.



Если вы не воспользуетесь программой Setup Assistant для переноса информации 
при первом запуске компьютера, вы можете сделать это позднее с помощью 
программы Migration Assistant. Откройте папку Applications, подпапку Utilities  
и дважды щелкните на значке Migration Assistant.

Замечание: Если вы будете переносить информацию позднее с помощью 
программы Migration Assistant, убедитесь, что на старом компьютере отключен 
FileVault. Чтобы отключить FileVault, откройте пульт Security (Безопасность)  
в System Preferences (Системных настройках) и щелкните Turn Off FileVault.
Следуйте инструкциям на экране.

Настройка Mac mini для работы в Интернет
Если вы не перенесли ваши сетевые настройки, Setup Assistant может помочь  
вам настроить на Mac mini подключение к Интернет. Если вы подключаетесь  
к Интернет дома, то для доступа требуется учетная запись поставщика Интернет-
услуг. Может взиматься плата. Если у вас есть учетная запись Интернет,  
обратитесь к Приложению C, «Подключение к Интернет», на странице 79  
для получения информации, которую вам нужно будет ввести.

Перевод Mac mini в режим сна или выключение
По окончании работы с Mac mini вы можете перевести ваш компьютер в режим 
сна или выключить его.

Перевод вашего Mac mini в режим сна
Если вы собираетесь вернуться к работе за вашим Mac mini через короткий 
промежуток времени, переведите компьютер в режим сна. Когда Mac mini 
находится в режиме сна, его экран отключен. Вы можете быстро «разбудить»  
Mac mini, минуя процесс запуска.

18 Глава 1 Начало работы
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Чтобы быстро перевести Mac mini в режим сна, выполните одну из следующих 
операций:
• Выберите пункт Apple (K) > Sleep из главного меню.

• Нажмите кнопку Power (®) на задней стенке корпуса Mac mini.

• Выберите пункт меню Apple (K) > System Preferences, щелкните на вкладке  
 Energy Saver и настройте таймер сна.

• Нажмите кнопку Play/Pause (’) на пульте Apple Remote и удерживайте  
 ее в течение 3 секунд.

Чтобы разбудить Mac mini, нажмите любую клавишу на клавиатуре или кнопку 
на пульте Apple Remote. При пробуждении Mac mini ваши программы, документы 
и настройки компьютера будут в том же состоянии, в котором вы их оставили.

Выключение Mac mini
Если вы не планируете использовать Mac mini в течение периода, превышающего 
несколько дней, выключите его. Выберите пункт Apple (K) > Shut Down  
из главного меню.

Предупреждение: Всегда выключайте Mac mini перед его перемещением. 
Перемещение компьютера при работающем (вращающемся) жестком диске  
может привести к его повреждению, и невозможности запуска компьютера  
с этого жесткого диска.
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В этой главе дается базовая информация,  
которую нужно знать о Mac mini.
Прочтите обзор различных компонентов компьютера и Mac OS X, сводную 
информацию по общим задачам, например, настройке изображения рабочего 
стола, подключению принтера, использованию сети Интернет и т.д.

Для получения самой последней информации
Так как компания Apple часто выпускает новые версии и пакеты обновления 
системного программного обеспечения, приведенные в этой книге изображения 
могут немного отличаться от того, что вы видите на экране. 

На сайте Apple содержатся самые последние новости компании Apple, бесплатно 
загружаемые программы и онлайн-каталоги программного и аппаратного 
обеспечения для Mac mini.

На сайте Apple Service & Support по адресу www.apple.ru/support можно также 
найти руководства по различным продуктам Apple и информацию технической 
поддержки по всем продуктам Apple.

Знакомство с Mac mini 2



Основные детали Mac mini: лицевая сторона

22 Глава 2 Знакомство с Mac mini

Антенна AirPort Инфракрасный 
приемник

Индикатор 
электропитания

Слот оптического 
дисковода
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Встроенный инфракрасный приемник 
Используется для приема сигналов, поступающих от пульта дистанционного 
управления Apple Remote.

Индикатор электропитания 
Светится белым, когда компьютер включен.  
Мигает белым, когда он находится в спящем режиме.

Оптический дисковод с упрощенной загрузкой 
Ваш компьютер оснащен оптическим дисководом DVD-ROM/CD-RW Combo Drive 
или DVD+R DL/DVD±RW/CD-RW SuperDrive. Любой из них может читать диски 
CD-ROM, стандартные аудиодиски, и другие диски с данными. Combo Drive может 
читать диски DVD и записывать диски CD-R/RW; SuperDrive также может записывать 
диски DVD±R, DVD±RW и DVD+R DL (двухслойные диски).

Встроенная антенна AirPort 
Технология AirPort Extreme позволяет подключаться к беспроводным сетям.  
Чтобы улучшить прием, не ставьте ничего на ваш компьютер и не загораживайте 
его, в особенности металлическими предметами.

Встроенный модуль Bluetooth® 
Используется для подключения беспроводных устройств (мобильные телефоны, 
карманные компьютеры, принтеры, беспроводные клавиатуры или мыши и другие).

Z

◊



Основные детали Mac mini: обратная сторона

24 Глава 2 Знакомство с Mac mini
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Слот безопасности 
Защитите свой Mac mini от кражи, подсоединив к нему трос безопасности 
(приобретается отдельно).

Гнездо для наушников 
Подсоединяйте наушники, колонки или другие цифровые аудио-устройства.

Гнездо линейного аудио-входа, цифровой оптический аудио-вход 
Для подключения микрофона или цифровых аудио-устройств.

Четыре порта USB 2.0 
Для подключения мыши, клавиатуры, принтера, внешнего USB модема  
и других устройств.

Порт DVI 
Для подсоединения монитора с разъемом DVI. Также можно подсоединять 
мониторы с разъемом VGA, используя переходник DVI-VGA, поставляемый  
вместе с компьютером. С помощью адаптера DVI to Video (приобретается отдельно) 
к компьютеру можно подключить телевизор, видеомагнитофон  
или другое видео-устройство.

Порт Ethernet 
Для подключения к сети 10/100Base-T Ethernet, DSL или кабельного модема.

Разъем питания 
Для подключения шнура питания компьютера.

Кнопка включения/выключения компьютера 
Включает и выключает Mac mini, а также переводит его в режим сна.  
Нажмите и удерживайте ее нажатой, чтобы принудительно выключить  
компьютер при зависании.

Порт FireWire 400 
Для подключения высокоскоростных устройств, таких как видеокамера iSight  
или внешний жесткий диск.
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Узнайте больше о Mac OS X
На ваш компьютер предустановлена операционная система Mac OS X 10.4 Tiger 
и пакет программ iLife. Если вы хотите подробнее узнать о Mac OS X и iLife, 
прочитайте буклет Welcome to Tiger, который входит в комплект поставки  
вашего Mac mini. Вы также можете обратиться к файлу справки Mac Help  
(смотрите стр. 27). В нем содержится подробная информация для новичков, 
опытных пользователей и пользователей, переходящих на Mac.  
Если у вас возникают проблемы при работе с Mac OS X, смотрите советы  
по поиску и устранению неисправностей в конце этой книги  
или выберите Help > Mac Help в главном меню.

Mac OS X включает в себя такие технологии как:

• Spotlight — улучшенную поисковую систему, автоматически индексирующую  
 все ваши файлы;

• Dashboard — интерфейс для того, чтобы различные удобные мини-программы  
 «виджеты» всегда были у вас под рукой;

• Exposé — для удобного размещения окон открытых программ на экране.

Для получения дополнительной информации о Mac OS X или совместимых  
с Mac OS X программах, посетите web сайт Apple по адресу www.apple.ru/macosx.
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Получение ответов в справочной системе Mac Help
Большая часть необходимой информации по работе с Mac mini доступна  
в справочной системе Mac Help.

Чтобы открыть файл справки Mac Help:
Щелкните на значке Finder в Dock (панели значков внизу экрана).

Выберите пункт меню Help > Mac Help (откройте меню Help в панели меню  
и выберите пункт Mac Help).

Щелкните на поле поиска, введите вопрос и нажмите клавишу Return  
на клавиатуре.
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Настройка вашего рабочего стола и установок пользователя
С помощью настроек системы вы можете быстро настроить вид вашего рабочего 
стола. Выберите пункт Apple (K) > System Preferences из главного меню.

Панель System Preferences — это ваш командный центр для настройки 
большинства параметров вашего Mac mini. По мере ознакомления с вашим 
компьютером вы узнаете о других системных настройках. Для получения 
дополнительной информации откройте файл Mac Help и произведите поиск  
по ключевым словам «System Preferences» или ключевым словам  
конкретной настройки.
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Подключение принтера
Многие модели принтеров можно подключить с помощью USB кабеля, для других 
требуется сетевое соединение (например, Ethernet). Если у вас есть базовая 
станция AirPort Express или AirPort Extreme Base Station, вы можете подключить 
USB принтер к базовой станции (вместо подключения к компьютеру) и обращаться 
к нему по беспроводной сети. Следуйте инструкциям, прилагающимся к вашему 
принтеру, для того, чтобы установить необходимое программное обеспечение  
и подключить принтер. Драйверы для большинства принтеров встроены  
в Mac OS X.

После подключения принтера ваш компьютер автоматически обнаружит его  
и добавит в список доступных принтеров. Перед тем как обращаться к принтерам, 
подключенным к сети, возможно, потребуется ввести их сетевые имена  
или адреса.

Чтобы настроить принтер:
Откройте System Preferences и щелкните на значке Print & Fax.

Нажмите кнопку Printing и кнопку Add (+), чтобы добавить принтер.

Выберите принтер и нажмите кнопку Add.

Для выбора принтеров из списка используйте кнопки Add (+) и Remove (–).

Контролирование печати
После отправки документа на принтер, вы можете контролировать печать —  
удалить или временно приостановить задачу печати. Чтобы открыть окно Printer, 
щелкните на значке принтера в Dock. Теперь вы можете видеть задания по выводу 
на печать в очереди на печать и работать с ними.

Для получения дополнительной информации выберите пункт меню  
Help > Mac Help и произведите поиск по ключевому слову «printing».
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Обновление программного обеспечения
Подключаясь к Интернет, вы можете автоматически загружать и устанавливать 
последние версии бесплатных программ, драйверов и других обновлений  
от Apple.

При подключении к Интернет функция Software Update проверяет наличие 
обновлений на серверах Apple. Можно настроить компьютер на периодическую 
проверку сервера Apple и загрузку/установку обновлений.

Чтобы проверить наличие обновлений:
Откройте System Preferences.

Щелкните на значке Software Update и следуйте инструкциям на экране.

1
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• Для получения дополнительной информации откройте файл справки Mac Help  
 и произведите поиск по ключевым словам «Software Update».

• Последнюю информацию о Mac OS X можно найти на сайте  
 www.apple.ru/macosx.

Подключение к сети 
Если вы хотите подключить ваш Mac mini к локальной сети Ethernet,  
кабельному модему, модему DSL или беспроводной сети, обратитесь  
к разделам «Подключение к локальной сети Ethernet» на странице 49  
и «Введение в беспроводную сеть AirPort Extreme» на странице 45 для получения 
информации о настройке соединения с локальной сетью Ethernet или соединения 
с AirPort. Вы также можете открыть Mac Help и сделать поиск по словам  
«Ethernet» или «AirPort».

Использование Internet
Когда вы в первый раз настраивали ваш Mac mini, Setup Assistant помог вам 
подключиться к Интернет. Если вам нужно перейти на другой тип соединения, 
такой как DSL или кабельный модем, сеть Ethernet (LAN), AirPort Extreme или 
другая беспроводная сеть, вы можете обратиться к Приложению C, «Подключение 
к Интернет», на странице 79 для получения более подробной информации. 
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Передача файлов на другой компьютер
Существует несколько способов передачи файлов или документов с или на ваш  
Mac mini.

• Вы можете легко передавать файлы, используя Setup Assistant. Для получения  
 дополнительной информации, обратитесь к разделу «Перенос информации  
 на Mac mini» на странице 17.

• Вы можете передавать файлы через Интернет, используя .Mac или другую  
 учетную запись Интернет. Посетите www.mac.com для получения более  
 подробной информации.

• Если ваш Mac mini подключен к локальной сети Ethernet, вы можете передавать  
 файлы на другой компьютер по локальной сети. Для того, чтобы получить  
 доступ к другому компьютеру или серверу, откройте окно Finder и нажмите  
 Network. Или же, если вы знаете название или сетевой адрес компьютера,  
 выберите Go > Connect to Server из главного меню Finder.

• Вы можете создать малую сеть Ethernet, соединив кабелем Ethernet ваш Mac mini  
 с портом Ethernet (G) другого компьютера. Для получения более подробной  
 информации, откройте Mac Help и сделайте поиск по словам  
 «connecting two computers».

• Вы также можете подключиться к другому Mac, используя кабель FireWire.  
 Ваш Mac mini показывается на другом компьютере как дисковый накопитель,  
 и вы можете передавать файлы. Для получения информации об использовании  
 FireWire для передачи файлов, откройте Mac Help и сделайте поиск по словам  
 «transferring files with FireWire».

• Вы также можете подключиться к беспроводной сети AirPort для передачи  
 файлов. Для получения более подробной информации, обратитесь к разделу  
 «Введение в беспроводную сеть AirPort Extreme» на странице 45.

Для получения более подробной информации о передаче файлов и документов, 
откройте Mac Help и сделайте поиск по словам «transferring files» или  
по необходимому вам типу соединения. 
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Использование программ
На ваш Mac mini установлены программы для отправки электронной почты, 
просмотра web-страниц и общения по сети. На него также установлен пакет 
программ iLife для организации музыки и цифровых фотографий, создания 
фильмов и т.п. Дополнительную информацию об этих программах можно найти  
в справочной системе. Запустите программу и выберите Mac Help  
из главного меню.

Когда программа не реагирует на ваши действия
В редких случаях программа на экране может зависнуть. Mac OS X предоставляет 
методы завершения работы зависшей программы без перезапуска компьютера. 
Завершение работы зависшей программы может позволить вам сохранить  
вашу работу в других открытых программах.

Для принудительного завершения работы программы:
Нажмите комбинацию клавиш Command (x)+Option+Esc или выберите пункт 
Force Quit из меню Apple (K). Появится диалоговое окно принудительного 
завершения работы программ.

Нажмите кнопку Force Quit.

Программа завершит свою работу, а все другие программы останутся открытыми.

1
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Mac mini наделен множеством встроенных функций, 
которые можно использовать для настройки компьютера 
нужным вам образом. 
Вот некоторые детали и возможности компьютера:

• Высокоскоростные порты USB 2.0 (d) для подсоединения дополнительного  
 оборудования, например принтеров, сканеров, джойстиков, клавиатур,  
 цифровых камер и дисководов. См. раздел «Использование USB» на стр. 41.

• Порт FireWire (H) для подсоединения высокоскоростного оборудования,  
 например iPod, камеры iSight, цифровой видеокамеры или внешнего жесткого  
 диска. См. раздел «Использование FireWire» на стр. 43.

• Встроенный модуль Bluetooth® (◊) для беспроводного подключения цифровых  
 устройств, например беспроводной клавиатуры Apple или беспроводной  
 мыши Apple. См. раздел «Использование Bluetooth» на стр. 47.

• Коммуникационные технологии — 10/100/1000Base-T Ethernet  
 и AirPort Extreme (Z) для работы в беспроводной сети. См. раздел на стр. 45.

• Разъем для наушников (f) для подсоединения наушников, колонок  
 с усилителем или другого цифрового аудио-оборудования.  
 См. «Подключение аудио-устройств», стр. 50.

• Аудио-вход/цифровой аудио-вход (,) для подключения микрофона  
 или цифрового аудио-оборудования. См. раздел «Подключение  
 аудио-устройств» на стр. 50.

Работа с Mac mini 3



Чтобы узнать, как работать с Mac mini, начните с информации в этой главе.  
Вы также сможете найти информацию в Mac Help и на сайте Mac mini по адресу 
www.apple.ru/support/macmini/.

Подключение монитора или видео-устройства
К выходу DVI (£) Mac mini можно подсоединить монитор с разъемом DVI. Если 
использовать один из описанных ниже адаптеров, то также можно подсоединить 
монитор с разъемом VGA или другое совместимое видео-устройство.

Адаптер DVI to VGA
Используйте адаптер DVI to VGA, который поставляется вместе с компьютером  
для подсоединения монитора с разъемом VGA.

Адаптер DVI to Video
Также можно подсоединить телевизор, видеомагнитофон или другое внешнее 
видеоустройство с помощью адаптера DVI to Video. Такой адаптер можно 
приобрести у официальных дилеров Apple.

Для получения информации по совместимости со сторонними мониторами 
обратитесь к документации, поставляющейся с монитором, или свяжитесь  
с производителем монитора.
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Порт видеовыхода

Адаптер DVI 
to VGA

Разъем VGA 
на кабеле 
монитора

Порт видеовыхода

Адаптер DVI 
to Video

Порты 
композитного 
видео-выхода 
и S-video
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Использование пульта Apple Remote и Front Row
Пульт дистанционного управления Apple Remote, поставляющийся с вашим  
Mac mini, работает через встроенный инфра-красный приемник и интерфейсом 
Front Row. Приемник сигнала находится на лицевой стороне вашего компьютера 
справа от оптического дисковода.

Пульт Apple Remote открывает Front Row, чтобы вы могли слушать музыку 
из вашей музыкальной фонотеки iTunes, смотреть слайд-шоу с вашими 
фотографиями и анонсы фильмов в QuickTime, проигрывать DVD-диски  
с помощью DVD Player и многое другое — из любого уголка комнаты.

Используйте пульт Apple Remote для:
• Запуска Front Row.

• Навигации по меню Музыка, Фото, Видео и DVD в программе Front Row.

• Навигации в iTunes, iPhoto и DVD Player.

• Перевода Mac mini в режим сна и пробуждения его.

Кроме пульта Apple Remote, программой Front Row можно также управлять  
с помощью клавиатуры. Соответствие клавиш кнопкам на пульте Apple Remote:

Клавиша Кнопка пульта Apple Remote

Command (x) — Esc Enter Menu (»)

Esc Exit Menu (»)

Пробел или Return Select/Play/Pause (’)

Стрелка вверх (Ò) Volume/Menu Up (+)

Стрелка вниз (¬) Volume/Menu Down (–)

Стрелка вправо (˚) Next/Fast forward (‘)

Стрелка влево (k) Previous/Rewind (])
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Чтобы воспользоваться пультом Apple Remote, направьте его на лицевую 
сторону вашего Mac mini:
• Нажмите кнопку Menu (»), чтобы открыть Front Row, а также для возврата  
 в предыдущее меню.

• Нажмите кнопки Next/Fast-forward (‘) или Previous/Rewind (]) для перемещения  
 по программам в Front Row.

• Нажмите кнопки Volume Up (+) и Volume Down (–) для перемещения  
 по пунктам меню и настройки громкости звука.

• Нажмите кнопку Select/Play/Pause (’), чтобы выбрать элемент меню, а также  
 для начала/остановки воспроизведения песни, слайдшоу, видео или DVD.

• Нажмите кнопки Previous/Rewind (]) или Next/Fast-forward (‘) для пропуска,  
 возврата к предыдущей композиции или перехода к следующей.  
 Удерживайте эти кнопки для быстрой перемотки вперед или назад.

MENU

Кнопка Volume Up

Кнопка Previous/Rewind

Кнопка Volume Down

Кнопка Menu

Окно ИК передатчика

Кнопка Next/Fast-forward

Кнопка Select/Play/Pause

Отсек для батарейки
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Привязка пульта Apple Remote к устройству
Если у вас в комнате находятся несколько компьютеров или других устройств  
с интегрированными ИК-приемниками (например, несколько компьютеров  
Mac mini или Mac mini в офисе или дома), вы можете «привязать» пульт Apple 
Remote к конкретному компьютеру или устройству. Привязка настраивает 
компьютер или устройство на управление только одним пультом Apple Remote.

Для привязки пульта Apple Remote с Mac mini:
Поднесите пульт Apple Remote к Mac mini (примерно на расстояние 8–10 см).

Направьте пульт Apple Remote на лицевую сторону Mac mini.

Нажмите и удерживайте кнопки Menu (») и Next/Fast-forward (‘) на пульте  
Apple Remote в течение 5 секунд.

При успешном соединении пульта Apple Remote с компьютером Mac mini,  
вы увидите на экране символ звеньев цепи ( ).

Чтобы удалить привязку между пультом Apple Remote и Mac mini:
Выберите пункт Apple (K) > System Preferences из главного меню. 

Нажмите Security, и затем нажмите Unpair.

Отключение ИК-приемника
В настройках Security можно включать и отключать ИК-приемник. 

Для отключения ИК-приемника: 
• Выберите пункт Apple (K) > System Preferences из главного меню  
 и нажмите Security.

• Установите флажок в пункте «Disable remote control infrared receiver».
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Замена батарейки
Пульт Apple Remote содержит батарейку. При необходимости, замените ее  
на батарейку CR 2032.

 
Для замены батарейки:
Откройте отсек для батарейки, нажав на кнопку маленьким предметом,  
как показано на рисунке.

Выдвиньте отсек для батарейки и выньте батарейку.

Вставьте новую батарейку стороной (+) вверх.

Закройте отсек для батарейки.

Предупреждение: Вставляйте батарею правильно, чтобы избежать риска взрыва. 
Соедините положительный полюс батареи с положительным полюсом держателя 
и используйте только батареи аналогичного типа. 

Дополнительная информация о пульте Apple Remote
Дополнительную информацию о пульте Apple Remote можно найти в файле 
справки Mac Help. Выберите пункт меню Help > Mac Help и произведите поиск  
по ключевому слову «Apple Remote».

MEN
U

Нажмите на эту кнопку с помощью маленького тупого 
предмета, чтобы открыть отсек для батарейки.

Сторона (+) должна быть сверху.

Выдвиньте отсек для батарейки.
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Использование USB
У вашего Mac mini есть 4 USB 2.0 (d) порта, которые вы можете использовать 
для того, чтобы подключать различные внешние устройства, включая принтер, 
сканер, iPod, цифровую камеру, джойстик, геймпэд, клавиатуру или дисковод для 
гибких дисков. С USB очень просто подключить внешние устройства. Чаще всего 
устройство USB можно как подсоединять, так и отсоединять во время работы 
компьютера. USB-устройство готово к работе сразу после подсоединения.

Использование USB-устройств
Для того, чтобы использовать USB-устройство с вашим Mac mini, просто 
подключите устройство к порту USB на вашем Mac mini. Ваш Mac mini 
автоматически осуществляет доступ к необходимому программному 
обеспечению, когда вы подключаете новое устройство. Вы можете подключать 
устройства USB 1.1 и высокоскоростные устройства USB 2.0 к портам USB 2.0  
на задней стороне вашего Mac mini. Устройства USB 1.1 не смогут  
воспользоваться преимуществом более высокой скорости USB 2.0.

Замечание: Apple уже включила программное обеспечение для работы  
со многими USB-устройствами. Когда вы подключаете USB-устройство, и ваш 
Mac mini не может найти подходящее программное обеспечение, вы можете 
установить программное обеспечение, входящее в комплект поставки вашего 
устройства или зайти на веб-сайт производителя устройства для получения 
последней версии программного обеспечения.

USB 2.0 порты



Работа с несколькими устройствами USB одновременно
Если все порты USB заняты, а вы хотите подключить большее количество 
устройств USB, вы можете приобрести концентратор USB. Концентратор 
USB подключается к свободному порту USB компьютера и предоставляет 
дополнительные порты USB (обычно четыре или семь). Некоторые концентраторы 
USB снабжены источником питания. Такие концентраторы следует подключать  
к розетке.

Замечание: Если вы используете цепь из устройств USB и концентраторов, 
некоторые устройства могут не работать, если их подключить через комбинацию 
из высокоскоростных концентраторов USB 2.0 и концентраторов USB 1.1. 
Например, вы можете не увидеть внешний USB жесткий диск на вашем рабочем 
столе. Чтобы избежать такой ситуации, не подключайте устройства USB  
с различной скоростью вместе. Подключите высокоскоростной концентратор  
к компьютеру, и подключите к нему высокоскоростные устройства.  
Точно также поступите с низкоскоростным концентратором  
и низкоскоростными устройствами.

Дополнительная информация о USB
Дополнительную информацию о USB можно найти в файле Mac Help  
(смотрите стр. 29). Выберите пункт меню Help > Mac Help и произведите поиск  
по ключевому слову «USB». Информацию можно найти также на сайте Apple USB 
по адресу www.apple.com/usb.

Для получения информации об устройствах USB, совместимых с вашим 
компьютером, обратитесь к руководству Macintosh Products Guide по адресу 
www.apple.com/guide.
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Подключение устройств FireWire
Ваш компьютер оснащен портом FireWire 400 (H). С помощью FireWire вы легко 
можете подключать и отключать внешние высокоскоростные устройства — 
цифровые видеокамеры, принтеры, сканеры, жесткие диски — без перезагрузки 
компьютера.

Вот некоторые возможности FireWire:

• Подключение цифровой видеокамеры, съемка, передача и редактирование  
 видео в высоком качестве непосредственно на компьютере с помощью  
 специального программного обеспечения, например, программ iMovie  
 (поставляется с Mac mini) или Final Cut Express или Final Cut Pro.

• Подключение внешнего жесткого диска FireWire для создания на нем резервных  
 копий данных или обмена файлами. Значок жесткого диска появится на вашем  
 рабочем столе, как только вы подключите его к Mac mini.

• Загрузка компьютера с внешнего жесткого диска FireWire. Подключите внешний  
 жесткий диск FireWire (с установленной на нем необходимой операционной  
 системой), откройте панель Startup Disk в System Preferences и щелкните  
 по значку жесткого диска FireWire (H). Перезагрузите компьютер.

Порт FireWire 400



Работа с устройствами FireWire
Для того, чтобы использовать устройство FireWire с вашим Mac mini, просто 
подключите устройство к порту FireWire (H). Apple уже включила программное 
обеспечение для работы со многими устройствами FireWire. Когда вы подключаете 
устройство FireWire, и ваш Mac mini не может найти подходящее программное 
обеспечение, вы можете установить программное обеспечение, входящее  
в комплект поставки вашего устройства или зайти на веб-сайт производителя 
устройства для получения последней версии программного обеспечения. 

Замечание: Порт FireWire (H) предоставляет питание устройствам FireWire 
(максимум до 8 Вт). Вы можете подключить несколько устройств друг к другу  
и подключить эту «гирлянду» устройств к порту FireWire (H) вашего компьютера, 
но получать питание от компьютера должно только одно устройство. Остальные 
устройства в гирлянде должны быть подключены к отдельным адаптерам питания. 
Подключение более одного устройства FireWire, нуждающегося в питании от порта 
компьютера, может привести к неполадкам. Если возникнет проблема, выключите 
компьютер, отключите устройства FireWire и перезапустите компьютер.

Подключение вашего Mac mini к другому компьютеру  
через интерфейс FireWire
Если вы хотите пересылать файлы между вашим Mac mini и другим компьютером 
Macintosh с портом FireWire, или у вас возникла проблема, не позволяющая 
вашему компьютеру запуститься, вы можете использовать режим FireWire Target 
Disk Mode для подключения к другому компьютеру. При запуске компьютера  
в режиме FireWire Target Disk Mode другой компьютер может получать доступ  
к вашему Mac mini, как к внешнему жесткому диску.

Для подключения вашего Mac mini к другому компьютеру в режиме  
FireWire Target Disk Mode:
Убедитесь, что ваш Mac mini выключен.

Подключите Mac mini к другому компьютеру с помощью кабеля FireWire.
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Запустите Mac mini, удерживая клавишу T. На экране отобразится логотип  
FireWire (H). На экране другого компьютера появится значок внутреннего 
жесткого диска вашего компьютера. После этого вы сможете копировать  
файлы между компьютерами.

После окончания копирования файлов перетащите значок жесткого диска  
Mac mini в корзину.

Нажмите кнопку Power (®) на Mac mini, чтобы выключить его, и отключите  
FireWire кабель.

Дополнительная информация о FireWire
Дополнительную информацию о FireWire можно найти в файле справки.  
Выберите пункт Help > Mac Help в главном меню Finder и произведите поиск  
по ключевому слову «FireWire». Можно также найти информацию на сайте  
Apple FireWire по адресу www.apple.com/firewire.

Зачем нужна беспроводная сеть AirPort Extreme
Ваш Mac mini оснащен технологией AirPort Extreme. Технология AirPort предлагает 
простой способ обеспечения доступа в Интернет. Вместо традиционных кабелей 
для обеспечения беспроводной связи между несколькими компьютерами  
AirPort Extreme использует технологию беспроводной локальной сети.  
Через беспроводную сеть вы можете установить доступ в Интернет,  
передавать файлы, играть в игры с несколькими игроками и многое другое.
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Как AirPort обеспечивает беспроводной доступ к Интернет 
С технологией AirPort Extreme, ваш Mac mini устанавливает беспроводную связь  
с AirPort Express или AirPort Extreme Base Station (базовой станцией), которая 
подключена к Интернет через телефонную линию или DSL-модем  
или кабельный модем.

Замечание: Для создания беспроводной сети вам потребуется базовая станция 
AirPort Express или AirPort Extreme и доступ в Интернет (может взиматься плата). 
Услуги некоторых поставщиков Интернет-услуг не допускают использования 
AirPort. Дальность действия AirPort зависит от расположения базовой станции  
и наличия препятствий, а также многих других факторов.
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Дополнительная информация об AirPort Extreme
Чтобы приобрести базовую станцию AirPort Extreme Base Station  
или AirPort Express, свяжитесь с официальным дилером Apple.

Дополнительную информацию об AirPort Extreme или AirPort Express можно найти 
в файле справки AirPort Help. Выберите пункт меню Help > Mac Help, а затем пункт 
Library > AirPort Help в меню Help Viewer. Информацию также можно найти  
на web сайте Apple AirPort по адресу www.apple.ru/airport.

Использование беспроводной технологии Bluetooth
Ваш Mac mini оснащен модулем для беспроводной связи Bluetooth 2.0+EDR.  
С помощью Bluetooth вы можете осуществлять беспроводное соединение 
ближнего действия между настольным и портативным компьютером, КПК, 
мобильными телефонами, принтерами, цифровыми камерами и беспроводными 
устройствами ввода, такими как клавиатура Apple Wireless Keyboard и мышь 
Apple Wireless Mouse (их можно купить у официальных дилеров Apple).

Беспроводная технология Bluetooth избавляет от необходимости использовать 
множество проводов, которые обычно соединяют устройства. Устройства 
Bluetooth могут подключаться друг к другу без проводов на расстоянии 
до 10 метров.

С помощью беспроводной технологии Bluetooth вы можете:

• Пересылать файлы между компьютерами или устройствами Bluetooth  
 (даже с Mac на PC).

• Устанавливать связь с КПК, поддерживающим Bluetooth. С помощью программы  
 iSync вы можете выполнять операции синхронизации без кабелей или отсылать  
 вашу визитную карточку или календарные события на КПК вашего коллеги.

• Использовать беспроводной Bluetooth принтер, клавиатуру, мышь 
 или наушники.



Настройка устройства Bluetooth
Перед использованием устройства Bluetooth с Mac mini необходимо настроить 
его. После настройки устройства оно «соединяется» с вашим компьютером,  
и вы можете видеть его в панели Devices настроек Bluetooth.  
Необходимо спарить ваш компьютер с устройством только один раз, после чего 
они останутся спаренными до тех пор, пока вы не удалите спаривание.

Для настройки устройства Bluetooth:
Выберите пункт (◊) > Set up Bluetooth Device в меню статуса Bluetooth.

Следуйте инструкциям на экране для настройки устройства.

Предупреждение: Если меню статуса Bluetooth (◊) нет в главном меню, откройте 
System Preferences и выберите пункт Bluetooth. Выберите пункт Settings и затем 
пункт «Show Bluetooth status in the menu bar».

Для удаления соединения с устройством Bluetooth:
Откройте System Preferences и выберите пункт Bluetooth.

Щелкните на пункте Devices и выберите устройство.

Нажмите Delete.

Дополнительная информация о беспроводной технологии Bluetooth
Дополнительную информацию о беспроводной технологии Bluetooth можно 
найти в файле справки Help > Bluetooth Help или в программе Bluetooth File 
Exchange (расположенном в подпапке Utilities папки Applications).  
Информацию также можно найти на web сайте Apple Bluetooth  
по адресу www.apple.com/bluetooth.
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Подключение к сети Ethernet
Ваш Mac mini оснащен встроенным сетевым портом Ethernet Base-T 10/100/1000 
Мегабит в секунду (Мбит/с), с помощью которого можно подключаться к сети  
или к DSL или кабельному модему.

Подключение к сети предоставляет вам доступ к другим компьютерам.  
Вы сможете сохранять и получать информацию, использовать сетевые принтеры  
и модемы, работать с электронной почтой и подключаться к Интернет.  
Ethernet можно использовать для обмена файлами между двумя компьютерами 
или для настройки небольшой сети. При подключении к другим устройствам  
с портом Ethernet нет необходимости использовать кроссовер. Для подключения 
к сети 10Base-T, 100Base-T или 1000Base-T Ethernet используйте кабель Ethernet 
категории 5 (или выше). Порт Ethernet (G) в Mac mini может автоматически 
обнаруживать другие устройства с портом Ethernet.

Дополнительная информация о работе с Ethernet
Дополнительную информацию о настройке сети Ethernet и пересылке файлов  
по сети Ethernet можно найти в файле справки Mac Help. Выберите пункт меню 
Help > Mac Help и произведите поиск по ключевым словам «Ethernet» или 
«network». Информацию о сетевых продуктах, совместимых с Mac mini, можно 
найти в руководстве Macintosh Products Guide по адресу www.apple.com/guide.

Порт Ethernet 
(10/100/1000Base-T)

�



Примечание: Вы также можете подключаться к другому компьютеру Macintosh, 
используя вместо Ethernet технологию IP over FireWire. FireWire 400 может 
предоставлять скорость соединения до 4 раз быстрее, чем через Ethernet.  
Для получения более подробных сведений, выберите пункт меню Help >  
Mac Help и произведите поиск по ключевым словам «FireWire network».

Использование аудио-устройств
Mac mini оснащен гнездом для наушников/оптический цифровой аудио-выход (f)  
и оптическим цифровым линейным аудио-входом (,). 

Гнездо для наушников/ оптический цифровой аудио-выход
К данному разъему (f) можно подключать внешние активные колонки, наушники, 
стереосистемы 5.1. Разъем для наушников одновременно является 3,5 мм  
S/PDIF стерео аудио-выходом. При подключении к нему наушников или любого 
другого устройства звук идет через это устройство, а встроенный динамик  
Mac mini автоматически отключается. Вы также можете транслировать музыку  
на стереосистему через iTunes и AirPort Express.
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Линейный аудио-вход/цифровой аудио-вход
Вы можете подключать к этому порту (,) внешние микрофоны или другие аудио-
устройства. Порт линейного аудио-входа одновременно является 3,5 мм S/PDIF 
стерео аудио-входом.

Порт аудио-входа не предоставляет питания подключенному устройству, поэтому 
следует использовать устройства с собственным питанием. С помощью адаптера 
Toslink можно подключить кабель Toslink к декам с цифровыми аудиокассетами 
(DAT) или цифровым инструментам для записи и микширования музыки.

Дополнительная информация о работе с аудио
Более подробные сведения об использовании аудио-устройств представлены  
в Mac Help. Выберите пункт меню Help > Mac Help и произведите поиск  
по ключевым словам «audio» или «music».  
Для получения сведений об устройствах, которые Вы можете использовать  
с Mac mini, обратитесь к Macintosh Products Guide по адресу www.apple.com/guide.

Линейный 
аудио-вход/цифровой 

аудио-вход
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Работа с оптическим дисководом
С помощью оптического дисковода вы можете устанавливать программы  
с CD или DVD дисков, воспроизводить музыкальные CD диски и DVD фильмы.  
Вы можете записывать музыкальные CD диски, которые можно воспроизводить 
в большинстве CD проигрывателей, и записывать документы и другие цифровые 
файлы на CD-R, CD-RW диски.

Если ваш Mac mini оснащен SuperDrive дисководом, вы также можете записывать 
ваше домашнее видео на DVD диски и смотреть его на стандартных DVD 
проигрывателях. Вы можете записывать музыкальные CD диски, которые можно 
воспроизводить в большинстве CD проигрывателей, и записывать документы  
и другие цифровые файлы на CD-R, CD-RW, DVD±R, DVD±RW и DVD+R Double Layer 
(DL) диски с помощью Finder. На диск DVD+R DL помещается почти вдвое больше 
данных (до 8,54 Гбайт).

Предупреждение: Дисковод SuperDrive в вашем Mac mini поддерживает 
стандартные круглые 12 см диски. Диски неправильной формы или диски 
меньшего размера не поддерживаются. Некруглые диски могут застрять  
в дисководе. Если диск застрял в дисководе, обратитесь к разделу поиска  
и устранения неисправностей на странице 63.

Замечание: Если у вас есть старая программа на гибких дисках, свяжитесь  
с разработчиком программы, чтобы выяснить, доступна ли программа на CD 
диске или для скачивания из Интернет. Вы также можете приобрести внешний  
USB дисковод для гибких дисков у официальных дилеров Apple.

52 Глава 3 Работа с Mac mini



53Глава 3 Работа с Mac mini

Вставка CD или DVD диска
Для установки или работы с программой на CD или DVD диске:
Вставьте диск в дисковод этикеткой вверх.

Когда на рабочем столе появится значок диска — диск готов к работе.

Замечание: Некоторые DVD-диски являются двухсторонними, поэтому этикетки 
нет ни на одной из сторон.

Извлечение диска
Для извлечения диска перетащите значок диска в корзину или нажмите кнопку 
Eject (C) на клавиатуре Apple (кнопка F12 на других клавиатурах). Если извлечь 
диск не удается, закройте все программы, которые могут использовать диск,  
и попытайтесь снова. Если это не срабатывает, перезагрузите компьютер, 
удерживая кнопку мыши.

Предупреждение: Ничего не ставьте на компьютер. Объекты, поставленные  
на компьютер, могут мешать извлечению диска.

Воспроизведение DVD дисков
Для воспроизведения DVD диска вставьте DVD диск в дисковод.  
Автоматически запустится программа DVD Player и начнет воспроизведение.
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Запись CD-R и CD-RW дисков
Вы можете записывать музыку на CD-R или CD-RW диски прямо из iTunes.

Для записи музыки на CD-R или CD-RW из iTunes:
Щелкните на значке iTunes в Dock.

Выберите список песен, которые вы хотите записать.

Вставьте пустой CD диск. (Для лучшей совместимости с CD плеерами  
используйте CD-R диски.)

Нажмите Burn CD в верхней части окна iTunes.

Для записи данных на CD-R или CD-RW диск из Finder:
Вставьте пустой диск в оптический дисковод.

В появившемся диалоговом окне введите название диска.  
Значок диска появится на рабочем столе. 

Перетащите файлы и папки на значок диска.

Выберите команду Choose File > Burn Disc или перетащите диск  
на значок Burn Disc в Dock.
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Запись информации на DVD диск
Ваш Mac mini оборудован дисководом SuperDrive, так что вы можете записывать 
собственные фильмы на DVD+R DL, DVD±RW или DVD±R диск. На DVD диск можно 
также записать другие цифровые данные, такие как резервные копии файлов.

Для записи данных на DVD-R диск из Finder:
Вставьте в дисковод пустой DVD+R DL, DVD±RW или DVD±R диск.

В появившемся диалоговом окне введите имя диска и выберите формат.

Дважды щелкните на значке DVD диска, который появилась на рабочем столе  
и перетащите туда файлы и папки.

Выберите команду Choose File > Burn Disc или перетащите диск на значок  
Burn Disc в Dock.

Вы также можете воспользоваться программой iDVD для создания собственных 
DVD-Video дисков. Для получения дополнительной информации о работе с iDVD 
запустите iDVD и выберите пункт меню Help > iDVD Help.

Дополнительная информация
Для получения дополнительной информации о записи музыкальных файлов  
на CD-R диск в программе iTunes запустите iTunes и выберите пункт меню Help > 
«iTunes and Music Store Help».

Для получения дополнительной информации о работе с DVD Player запустите  
DVD Player и выберите пункт меню Help > DVD Player Help.
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Защита Mac mini
Используйте тросик с замком и встроенный слот безопасности, чтобы защитить 
ваш Mac mini. Вы можете приобрести тросик с замком для защиты вашего  
Mac mini у дилеров Apple.

Дополнительную информацию о программных способах защиты вашего Mac mini, 
включая возможности шифрования файлов и установки паролей для нескольких 
пользователей, можно найти в файле справки Mac Help. Выберите пункт меню 
Help > Mac Help и произведите поиск по ключевым словам «security»  
или «multiple users».
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Если у вас возникают проблемы при работе с вашим  
Mac mini, обратитесь к приведенному здесь списку 
возможных решений и советов.
В этой главе содержатся решения проблем, которые мешают работе  
с компьютером, например зависания системы или невозможность загрузки 
компьютера. Вы также можете найти дополнительную информацию о поиске  
и устранении неисправностей в файле справки Mac Help (см. страницу 29)  
и на сайте Apple Service & Support по адресу www.apple.ru/support.

Если у вас возникла проблема, обычно для нее существует простое и быстрое 
решение. Обратите внимание на условия, которые привели к возникновению 
проблемы. Рассмотрение того, что вы сделали перед появлением проблемы, 
поможет вам сузить круг возможных причин и найти нужный вам ответ. Вещи, 
на которые следует обратить внимание:

• Программы, которые вы использовали при появлении проблемы.  
 Проблемы, появляющиеся при использовании конкретной программы, могут  
 указывать на то, что программа не совместима с версией Mac OS,  
 установленной на ваш компьютер.

• Любые программы, которые вы недавно установили, особенно программы,  
 которые добавляют элементы в Системную папку.

• Любая установленная вами новая аппаратура, такая как дополнительная память  
 или периферийное устройство.

Поиск и устранение  
неисправностей 4



Проблемы, мешающие использовать ваш компьютер
Если компьютер не реагирует или указатель курсора не двигается
• Убедитесь, что мышь и клавиатура подключены к компьютеру. Отсоедините  
 и снова подключите их и убедитесь, что они правильно подключены.

• Если это не помогает, нажмите комбинацию клавиш Command (x)+Option+Esc  
 (на других клавиатурах — Alt+Windows+Esc) для принудительного завершения  
 работы зависшей программы. Когда появится диалоговое окно, выберите  
 программу, работу которой вы хотите завершить, и нажмите Force Quit.  
 Затем сохраните вашу работу во всех открытых программах и перезапустите  
 компьютер, чтобы быть уверенным, что проблема полностью исчезла.

• Если вы не можете принудительно завершить работу программы, нажмите  
 и удержите кнопку Power (®) в течение нескольких секунд, чтобы выключить  
 компьютер.

• Если это не помогает, отсоедините шнур питания из Mac mini. Потом подключите  
 его обратно и нажмите клавишу Power (®), чтобы включить компьютер.

Если проблема возникает часто, выберите пункт Help > Mac Help из панели меню  
в верхней части экрана. Произведите поиск по ключевому слову «freeze»,  
чтобы увидеть статьи справки о случаях зависания компьютера.

Если проблема возникает только тогда, когда вы используете конкретную 
программу, обратитесь к разработчику программы, чтобы выяснить, совместима 
ли она с вашим компьютером. Если вы уверены, что программа совместима, 
однако проблемы возникают часто, попробуйте переустановить систему 
(см. страницу 60).
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Если компьютер зависает во время загрузки или появляется мигающий 
вопросительный знак
• Подождите несколько секунд. Если компьютер не загрузится после паузы,  
 выключите его, нажав кнопку Power (®) и удерживая ее нажатой в течение  
 5 секунд. Затем нажмите и удержите кнопку Option и снова нажмите кнопку  
 Power (®). Во время запуска компьютера щелкните на значке жесткого диска,  
 а затем на стрелке вправо.

• После запуска компьютера откройте System Preferences и нажмите Startup Disk.  
 Выберите локальную папку Mac OS X System.

• Если это не поможет, возможно вам необходимо переустановить системное  
 программное обеспечение вашего компьютера. Обратитесь к разделу  
 «Восстановление программного обеспечения вашего компьютера» 
 на странице 60.

Если компьютер не включается или не запускается
• Убедитесь, что шнур питания подключен к Mac mini и к исправной  
 электрической розетке.

• Если это не помогает, нажмите кнопку Power (®) и сразу же нажмите 
 и удерживайте клавиши Command (x), Option, P и R до появления второго  
 звукового сигнала. На других клавиатурах нажмите кнопку Power (®) 
 и сразу же нажмите и удерживайте клавиши Windows, Alt, P, и R.

• Если и это не помогает, отключите шнур питания от компьютера, подождите 
 30 секунд, вновь подключите шнур и попробуйте включить его снова.

• Если компьютер все равно не запускается, обратитесь к информации 
 по обслуживанию и поддержке, которая поставлялась вместе с вашим Mac mini,  
 для обращения в сервисную службу Apple.
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Восстановление программного обеспечения 
вашего компьютера
Используйте диски установки и восстановления программного обеспечения, 
поставляемые вместе с вашим компьютером, для установки Mac OS X и программ, 
поставляемых вместе с компьютером.

Предупреждение: Apple рекомендует создать резервные копии данных с вашего 
жесткого диска перед установкой программ. Apple не несет ответственности  
за потерю данных.

Установка Mac OS X
Для установки Mac OS X выполните следующие шаги:
Создайте резервные копии важных файлов.

Вставьте диск Mac OS X Install Disc 1, включенный в поставку вашего компьютера.

Дважды щелкните на значке Install Mac OS X and Bundled Software.

Следуйте инструкциям на экране.

После выбора целевого диска для установки продолжайте следовать инструкциям 
на экране. Ваш компьютер может перезапуститься и попросить вставить 
следующий установочный диск Mac OS X.

Предупреждение: Так как «Erase and Install» стирает все данные на вашем целевом 
диске, перед установкой Mac OS X и других программ следует создать резервные 
копии важных файлов.
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Установка программ
Для установки программ, включенных в поставку вашего компьютера,  
выполните следующие шаги.

Чтобы установить программы:
Создайте резервные копии ваших файлов.

Вставьте в дисковод диск Mac OS X Install Disc 1.

Дважды щелкните на пункте «Install Bundled Software Only».

Следуйте инструкциям на экране.

После выбора целевого диска, продолжайте следовать инструкциям на экране.

Замечание: Для установки программ iCal, iChat, iSync, iTunes и Safari,  
следуйте инструкциям раздела «Установка Mac OS X».

Другие проблемы
Если вы испытываете трудности с запуском программы
Определите тип программы, которую вы пытаетесь открыть, выделив значок 
программы и выбрав Get Info из меню File.

С нашим компьютером вы можете использовать Universal программы, программы 
для Intel или PowerPC.

Программы для Classic (или Mac OS 9) не совместимы с вашим компьютером.  
Они не будут запускаться.
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Если у вас возникают проблемы при работе с программой
• Для решения проблем с программами, разработанными не Apple, обратитесь  
 к разработчику. Разработчики программ часто предоставляют обновления  
 программ на своих сайтах.

 Вы можете сконфигурировать ваш Mac mini для автоматической проверки  
 и установки обновлений программ от Apple, используя панель Software Update  
 в System Preferences. Для получения дополнительной информации выберите  
 пункт Help > Mac Help в панели меню и произведите поиск по ключевым словам  
 «Software Update».

Если у вас возникают проблемы при использовании беспроводной связи  
через AirPort Extreme
• Убедитесь, что вы сконфигурировали программное обеспечение в соответствии  
 с инструкциями, поставляемыми с вашим AirPort Extreme Base Station  
 или AirPort Express.

• Убедитесь, что компьютер или сеть, к которой вы пытаетесь подключиться,  
 работает и имеет точку беспроводного доступа.

• Убедитесь, что вы находитесь в зоне действия антенны другого компьютера  
 или точки доступа сети. Расположенные рядом электронные устройства  
 или металлические предметы могут помешать беспроводной связи и сократить  
 зону действия сети. Перемещение или поворот компьютера может улучшить  
 качество приема.

• Проверьте уровень сигнала AirPort. В главном меню вы найдете до 4 полосок,  
 показывающих силу сигнала AirPort.

• Вы можете столкнуться с проблемами сети если рядом с вашей точкой доступа  
 присутствуют микроволновая печь, беспроводной телефон или другие  
 подобные устройства. Чтобы уменьшить интерференцию, переместите точку  
 доступа подальше от этих устройств.
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• Обратитесь к файлу справки AirPort Help (выберите пункт меню Help > Mac Help,  
 затем выберите пункт Library > AirPort Help) и к инструкции, прилагавшейся  
 к вашему беспроводному устройству, для получения дополнительной  
 информации.

Если у вас возникают проблемы при извлечении диска

• Закройте все программы, которые могут использовать диск, и нажмите клавишу  
 извлечения диска (C) на клавиатуре.

• Если это не помогает, откройте окно Finder и щелкните по значку извлечения  
 диска, которая отображена справа от диска в боковом отсеке, или перетащите  
 значок диска со стола в корзину.

• Если это не сработает, выйдите из системы, выбрав меню Apple > Log Out «User»  
 (Ваше имя пользователя будет отображено в меню) и нажмите клавишу  
 Media Eject (C) на вашей клавиатуре. 

• Если это не поможет, перезапустите Mac mini, удерживая кнопку мыши.

Если у вас возникают проблемы при соединении с Интернет
• Убедитесь, что сетевой кабель подключен и работает.

• Если вы используете коммутируемое соединение с Интернет, убедитесь,  
 что ваш телефонный провод подключен к внешнему модему Apple USB Modem  
 (приобретается отдельно), а не к порту Ethernet (G) на компьютере.

• Обратитесь к разделу «Подключение к Интернет» на странице 79 для получения  
 информации о том, как настроить ваш Mac mini для подключения к Интернет.  
 Там вы найдете информацию о том, как обнаружить ваши настройки Интернет  
 и контактную информацию для вашего поставщика услуг Интернет (если вы  
 использовали Setup Assistant для получения вашей учетной записи Интернет).

• Обратитесь к разделу «Поиск и устранение проблем с вашим подключением»  
 на странице 84 для получения более подробной информации,  
 если вы испытываете трудности с подключением к Интернет.



Если у вас возникают проблемы при использовании компьютера  
или при работе с Mac OS
• Если вы не нашли ответы на ваши вопросы в данном руководстве, обратитесь  
 к файлу справки Help > Mac Help для получения инструкций и поиска  
 информации по устранению неисправностей.

• Посетите сайт Apple Support по адресу www.apple.ru/support/ для получения  
 самых свежих обновлений программ и информации по поиску и устранению  
 неисправностей.

Если настройки даты и времени постоянно сбиваются
• Вам необходимо заменить внутреннюю резервную батарею.  
 Вы не сможете заменить батарею самостоятельно.

• Обратитесь к авторизованному сервисному партнеру Apple.

Работа с программой Apple Hardware Test
Программу Apple Hardware Test можно использовать для обнаружения 
аппаратных проблем в компьютере.

Как работать с Apple Hardware Test:
Отключите от компьютера все внешние устройства, кроме клавиатуры и мыши.
Если к компьютеру подключен кабель Ethernet, отключите и его.

Вставьте в компьютер диск Mac OS X Install Disc 1, который был в комплекте  
с вашим компьютером.

Перезапустите компьютер и удерживайте нажатой клавишу D в начале загрузки.

Выберите язык, соответствующий вашему местоположению,  
когда в Apple Hardware Test появится экран выбора языка.

Нажмите клавишу Return или нажмите кнопку «стрелка вправо». 
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При появлении главного экрана Apple Hardware Test (примерно через 45 секунд) 
следуйте инструкциям на экране. код ошибки. Запишите код ошибки,  
прежде чем обращаться в службу поддержки.

Если программа Apple Hardware Test обнаружит проблему, она покажет код 
ошибки. Запишите код ошибки, прежде чем обращаться в службу поддержки.  
Если Apple Hardware Test не обнаружит сбоев аппаратного обеспечения,  
проблема может быть связана с программным обеспечением.

Более подробную информацию о программе Apple Hardware Test вы найдете  
в текстовом файле Apple Hardware Test Read Me на диске Mac OS X Install Disc 1.

Выяснение серийного номера вашего компьютера
Вы можете найти серийный номер вашего Mac mini на нижней стороне подставки. 
Также вы можете найти его с помощью программы System Profiler.  
Выберите команду Apple (K) > About This Mac в главном меню, затем щелкните  
по кнопке More Info. Щелкните по треугольнику раздела Hardware,  
чтобы увидеть серийный номер.
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Вы можете использовать программу System Profiler  
для выяснения детальной информации о вашем Mac mini, 
такой как объем оперативной памяти, размер жесткого 
диска, данные о подключенных устройствах  
и серийный номер компьютера.
Для доступа к информации в System Profiler выберите пункт Apple (K) >  
About This Mac в главном меню, и затем нажмите More.

Спецификации A П
ри

ло
ж

ен
ие



68 Приложение А Спецификации

Дополнительная информация доступна в Интернет на сайте  
www.apple.ru/Macmini и www.apple.ru/support.

Чтобы отображать и скрывать информацию 
различных категорий щелкните  
на треугольниках в окне.
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Для вашей безопасности и безопасности вашего 
оборудования соблюдайте меры предосторожности при 
чистке и уходе за вашим Mac mini, описанные в этой главе.
Продукты Apple соответствуют последним стандартам безопасности электронного 
оборудования. Однако для обеспечения безопасной эксплуатации необходимо 
следовать инструкциям по безопасности, напечатанным на самом продукте  
и в документации.

Общие инструкции по безопасности
Для вашей личной безопасности и безопасности вашего оборудования, 
соблюдайте следующие меры предосторожности.

Отсоединяйте штекер питания (взявшись за штекер, не за шнур) и отключайте 
телефонный шнур в любом из следующих условий:

• Если шнур питания перетерся или повредился.

• Если вы пролили жидкость на корпус компьютера.

• Если ваш компьютер попал под дождь или в другие условия  
 с избыточной влажностью.

• Если кто-нибудь уронил ваш компьютер, или его корпус повредился.

• Когда вы считаете, что вашему компьютеру необходим ремонт  
 или обслуживание.

• Когда вы хотите почистить корпус (следуйте приведенным ниже инструкциям 
 на странице 74).
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Предупреждение: Единственный способ полностью отключить питание — 
отсоединить шнуры питания, Ethernet, FireWire и USB. Убедитесь, что хотя бы один 
конец шнура питания находится в пределах досягаемости, чтобы вы с легкостью 
могли обесточить Mac mini при необходимости.

Предупреждение: Ваш шнур питания оснащен трех-штырьковой вилкой, которая 
подходит только к розетке с заземлением. Если вы не можете вставить вилку 
в розетку, которая не имеет заземления, обратитесь к сертифицированным 
электрикам для установки розетки с заземлением. Не пытайтесь разобрать  
вилку с заземлением.

Всегда выполняйте следующие правила:

• Держите ваш компьютер вдали от источников влаги, таких как напитки,  
 умывальные раковины, ванны, душевые и т.д.

• Защищайте ваш компьютер от сырости, дождя, снега и тумана.

• Внимательно прочтите все инструкции по установке перед включением  
 компьютера.

• Храните эти инструкции поблизости для того, чтобы вы или другие  
 всегда смогли ими воспользоваться.

• Следуйте всем инструкциям.
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Предупреждение: Электрическое оборудование может представлять опасность 
при неправильной эксплуатации. Работа с этим продуктом должна проходить 
под контролем взрослых. Не разрешайте детям проникать внутрь любого 
электрического прибора и не позволяйте им играть с кабелями.

Предупреждение: Не заталкивайте никакие объекты в данный продукт через 
отверстия в корпусе. Это опасно и может привести к поломке вашего компьютера.

Не пытайтесь самостоятельно чинить
Ваш Mac mini не содержит никаких частей, заменяемых пользователем.  
Не пытайтесь открыть корпус компьютера. Не пытайтесь открыть корпус вашего 
Mac mini. Если ваш Mac mini нуждается в сервисном обслуживании, свяжитесь  
с авторизованным сервисным центром Apple. Если вы откроете корпус вашего 
Mac mini, вы рискуете повредить ваше оборудование и оно не будет устранено  
по гарантии.

Разъемы и порты
Никогда не применяйте силу при вставке разъема в порт. Если разъем не удается 
вставить в порт с разумным усилием, они, возможно, не подходят друг другу. 
Убедитесь, что разъем подходит к порту, и что вы правильно ориентировали 
разъем по отношению к порту.



Использование адаптера питания
Следуйте инструкциям при использовании адаптера питания:

• Убедитесь, что шнур питания надлежащим образом подсоединен  
 к адаптеру питания.

• Всегда оставляйте место около адаптера источника питания и устанавливайте  
 компьютер в том месте, в котором ничего не мешает циркуляции воздуха 
 около адаптера питания.

• Единственным способом полного отключения электропитания является  
 отсоединение шнура питания. При отключении держитесь за штекер, 
 а не за шнур.

• Используйте только адаптер из комплекта поставки вашего компьютера. 
 Mac mini поставляется с адаптером, мощностью 110 Вт.

Предупреждение: При использовании адаптер может нагреваться, 
это нормально. Всегда обеспечивайте необходимую вентиляцию вокруг адаптера.
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Предупреждение: Адаптер питания для компьютера является высоковольтным 
компонентом и ни в коем случае не должен вскрываться, даже если отсоединен. 
Не давайте детям доступа к внутренности любого электрического изделия 
и не позволяйте им трогать кабели. Если адаптер питания нуждается 
в обслуживании, обратитесь к сведениям о дополнительной поддержке, 
поставляющимся с вашим компьютером.

Предупреждение: Используйте только тот адаптер питания, который 
поставляется с компьютером, и только тот шнур питания, который поставляется 
с адаптером питания. Адаптеры и шнуры для других электронных устройств 
могут иметь аналогичный вид, но их использование может повлиять 
на производительность компьютера или повредить компьютер. 
Ваш шнур питания оснащен трех-штырьковой вилкой, которая подходит только 
к розетке с заземлением. Если вы не можете вставить вилку в розетку, которая 
не имеет заземления, обратитесь к сертифицированным электрикам 
для установки розетки с заземлением.

Информация о лазере
Предупреждение: Настройка или выполнение операций, не описанных 
в документации оборудования, может подвергнуть вас опасному облучению.

Не пытайтесь вскрыть корпус, внутри которого находится лазер. Используемый 
в данном продукте лазерный луч опасен для ваших глаз. Использование 
оптических инструментов, таких как увеличительные стекла, увеличивает 
потенциальную опасность излучения для ваших глаз. Чтобы обеспечить 
максимальную безопасность, для обслуживания данного оборудования 
рекомендуется вызывать сертифицированного специалиста Apple.



Вследствие наличия в Mac mini оптического дисковода, ваш компьютер имеет 
категорию лазерного продукта Class 1. Наклейка Class 1, расположенная  
в доступной пользователю области, указывает на то, что дисковод соответствует 
минимальным требованиям по обеспечению безопасности. Сервисная наклейка 
находится в области, доступной ремонтнику. Наклейки на вашем продукте  
могут немного отличаться от наклеек, изображенных здесь.

Предупреждение о повышенном риске
Данный компьютер не предназначен для управления ядерными реакторами, 
навигационными или коммуникационными системами самолета, диспетчерским 
или любым другим оборудованием, сбой которого может привести к смерти, 
ранениям или экологическим катастрофам.

Чистка Mac mini
При чистке внешних поверхностей Mac mini и его компонентов соблюдайте 
следующие правила:

• Выключите Mac mini и отсоедините шнур питания.

• Для очистки компьютера снаружи используйте влажную, мягкую ткань.  
 Избегайте попадания влаги внутрь компьютера через отверстия. 
 Не распыляйте жидкость непосредственно на компьютер.

• Не применяйте аэрозольные распылители, растворители 
 и абразивные материалы.
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Сервисная наклейкаНаклейка Class 1



Перемещение Mac mini
Прежде чем поднимать или перемещать ваш Mac mini, отключите все кабели  
и провода, подключенные к нему.

Избегайте повреждения слуха
Предупреждение: Использование наушников при повышенном уровне  
громкости может привести к потере слуха. Со временем вы можете привыкнуть  
к большой громкости, которая будет казаться нормальной, но вредит вашему 
слуху. Если вы слышите звон в ушах, уменьшите громкость или прекратите 
использовать наушники. 

Apple и окружающая среда
Apple Computer Inc. осознает свою ответственность и старается  
минимизировать влияние на окружающую среду ее продуктов  
и производственного процесса. Для получения дополнительной информации 
посетите сайт www.apple.com/environment/summary.html.

Информация об эргономичности

Монитор
Расположите монитор таким образом, чтобы его верх находился чуть ниже  
вашего уровня глаз, когда вы сидите за клавиатурой.  
Выбор наилучшего расстояния между экраном и вашими глазами остается  
за вами, но большинство людей предпочитает от 45 до 70 сантиметров. 
Расположите экран таким образом, чтобы свести к минимуму блики  
и отражения на экране от верхнего освещения и окон.
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Кресло
Лучше всего использовать прочное удобное кресло с регулируемой высотой. 
Отрегулируйте высоту кресла, чтобы бедра были немного наклонены и ваши 
ноги стояли на полу. Спинка кресла должна поддерживать низ спины (поясницу). 
Следуйте инструкциям производителя кресла для настройки положения спинки.

Чтобы ваши предплечья и кисти образовывали нужный угол, возможно, 
придется приподнять ваше кресло. Если при этом ваши ноги не достают до пола, 
используйте подставку для ног с настраиваемой высотой и наклоните ее так, 
чтобы под ногами не было пустого пространства. Вы также можете уменьшить 
высоту стола, если не хотите использовать подставку для ног. Еще один вариант —  
использовать стол с выдвижной подставкой для клавиатуры, расположенной 
ниже обычной поверхности стола.
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45–70 сантиметров

Бедра слегка 
наклонены

Плечи расслаблены

Экран расположен так,  
чтобы избежать 
отраженных бликов

Предплечье 
и кисти 
на прямой 
линии

Предплечья 
выровнены или 
слегка наклонены

Опора для 
нижней части 
спины

Ноги твердо стоят на полу 
или на подставке для ног

Верх экрана находится 
чуть ниже уровня глаз.  
(Возможно, вам придётся 
регулировать высоту 
вашего дисплея  
путем опускания  
или поднимания вашей 
рабочей поверхности.)

Свободное пространство 
под рабочей поверхностью
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Мышь
Используя внешнюю мышь, расположите ее на той же высоте, что и клавиатуру. 
Оставьте достаточно места для перемещения мыши.

Клавиатура 
Когда вы используете клавиатуру, ваши плечи должны быть расслаблены.  
Верхняя часть вашей руки и предплечье должны составлять угол, немного больше 
прямого угла, а ваше запястье и кисть должны составлять примерно  
прямую линию. 

Касайтесь клавиатуры легко, когда печатаете и старайтесь держать ваши руки  
и пальцы расслабленными. Не загибайте большие пальцы под ладони. 

Чаще меняйте положение рук, чтобы избежать усталости.  
Некоторые пользователи компьютеров могут почувствовать дискомфорт  
в кистях, запястьях или руках после интенсивной работы без перерывов.  
Если у вас начинает развиваться хроническая боль или дискомфорт в кистях, 
запястьях или руках, обратитесь к квалифицированному врачу.

Дополнительная информация
Посетите сайт www.apple.com/about/ergonomics.
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Ваш Mac mini можно использовать для работы в Интернет, 
отправки электронных писем друзьям и членам семьи  
и общения через Интернет в режиме реального времени. 
Приведенная ниже информация поможет вам 
настроить соединение с Интернет.
При первом запуске Mac OS X программа Setup Assistant предложит вам  
ввести конфигурационные данные вашего соединения с Интернет. Если вы  
не воспользовались Setup Assistant для настройки соединения с Интернет, 
вы можете использовать программу Network Setup Assistant (см. раздел 
«Использование Network Setup Assistant для установки соединения»  
на странице 83).

Есть четыре типа соединения с Интернет:
• Соединение через высокоскоростной DSL или кабельный модем:  
 Ваш компьютер подключается с помощью Ethernet кабеля к специальному  
 модему, который вы получаете от вашего провайдера Интернет-услуг.

• Беспроводное соединение через AirPort Extreme: Ваш компьютер  
 подключается к Интернет по беспроводной сети с помощью AirPort Extreme  
 Base Station или к другой беспроводной сети.

• Локальная сеть (LAN): Ваш компьютер подключается к сети LAN с помощью  
 Ethernet кабеля. Такой тип соединения обычно используется на рабочих местах.

• Коммутируемое соединение: Внешний модем подключается к USB (d)  
 порту вашего компьютера и к телефонной розетке.

Подключение к Интернет С П
ри

ло
ж

ен
ие
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Перед подключением к Интернет:
Настройте учетную запись для вашего провайдера Интернет-услуг.

Выясните у провайдера Интернет-услуг или сетевого администратора 
информацию, необходимую для установки соединения. Обратитесь к следующему 
разделу «Сбор необходимых данных», чтобы узнать, какая информация 
необходима для каждого типа соединения. Вы можете вписать данные в поля  
на следующих нескольких страницах и затем ввести их в программу Setup Assistant.

Если на вашем рабочем месте уже есть подключенный к Интернет компьютер,  
вы можете использовать его настройки.

Чтобы выяснить настройки компьютера с Mac OS X:
• Откройте пульт Network в System Preferences.

• Выберите тип соединения из выпадающего меню Show.

• Скопируйте оттуда всю необходимую информацию.

Чтобы выяснить настройки компьютера Windows PC:
Данные о соединении в Windows хранятся в двух местах.

• Чтобы выяснить IP адрес и маску подсети, откройте панель управления  
 «Network and Internet Connections»

• Чтобы выяснить данные учетной записи пользователя, откройте  
 панель управления User Accounts.

1

2
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Если вы используете внешний модем Apple USB Modem (продается отдельно), 
подключите его к Mac mini и подключите телефонный провод (не прилагается)  
к модему и телефонной розетке. Если вы используете DSL или кабельный модем, 
для подключения его к вашему компьютеру следуйте инструкциям,  
изложенным в документации этого модема.

Включите ваш компьютер и введите необходимые данные в программу  
Setup Assistant для настройки соединения с Интернет.

Если вы уже запустили ваш компьютер и не воспользовались программой 
Setup Assistant для настройки соединения с Интернет, обратитесь к разделу 
«Использование Network Setup Assistant для установки соединения» на стр. 83.

Сбор необходимых данных
На этих страницах вы можете записать информацию, полученную от вашего 
провайдера Интернет-услуг, сетевого администратора или с другого компьютера, 
и затем ввести ее в программу Network Setup Assistant.

Для настройки телефонного коммутируемого соединения вам потребуется 
следующая информация:
• Название провайдера услуг

• Имя пользователя или учетной записи

• Пароль

• Телефонный номер провайдера Интернет-услуг

• Дополнительный телефонный номер

• Префикс для выхода на внешнюю линию

3
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Чтобы настроить соединение через DSL модем, кабельный модем, локальную 
сеть или беспроводную сеть AirPort Extreme:
Выберите метод соединения (если вы не уверены, выясните метод соединения  
у вашего администратора или провайдера Интернет-услуг):

• Вручную

• DHCP с вводом адреса вручную

• DHCP

• BootP

• PPP

Если вы не знаете, какой метод использовать, выберите «DHCP», поскольку сеть 
обычно предоставляет большую часть необходимой информации автоматически.

Если вы выбрали метод «Вручную» или «DHCP с вводом адреса вручную», 
выясните следующие данные:

• IP адрес

• Маска подсети*

• Адрес маршрутизатора*

* Если вы выбрали метод «DHCP с вводом адреса вручную», вводить маску подсети 
и адрес маршрутизатора не нужно.

Если вы выбрали метод «DHCP», выясните следующую дополнительную 
информацию (спросите у вашего провайдера Интернет-услуг, нужна ли она):

• ID клиента DHCP

• адреса DNS серверов
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Если вы выбрали метод «PPP», (для соединения PPPoE) выясните  
следующую информацию:

• Название провайдера услуг

• Имя пользователя или учетной записи

• Пароль

• Имя службы PPPoE

Приводимая ниже информация может быть лишней. Выясните у вашего 
провайдера Интернет-услуг или системного администратора, нужна ли она вам.

• Адреса DNS серверов

• Имя домена

• Адрес Proxy сервера

Использование Network Setup Assistant  
для установки соединения
Если вы не воспользовались программой Setup Assistant для настройки 
соединения с Интернет при первом запуске Mac mini, вы можете настроить 
соединение или изменить его настройки в любое другое время с помощью 
программы Network Setup Assistant.

Чтобы запустить Network Assistant:
Выберите пункт меню Apple (K) > System Preferences.

Щелкните на вкладке Network и нажмите кнопку «Assist me».

Щелкните на значке Assistant, чтобы запустить Network Assistant.

Следуйте инструкциям на экране.

1
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Дополнительную информацию о настройке соединения с Интернет можно найти 
в файле справки Mac Help. Выберите пункт меню Help > Mac Help и произведите 
поиск по ключевым словам «connecting to the Internet».

Устранение неисправностей соединения
Если у вас возникают проблемы при соединении с Интернет, попытайтесь 
выполнить инструкции, предлагаемые в данном разделе для каждого типа 
соединения, или воспользуйтесь программой Network Diagnostics.

Чтобы запустить Network Diagnostics:
Выберите пункт меню Apple (K) > System Preferences.

Щелкните на вкладке Network и нажмите кнопку «Assist me».

Щелкните на значке Diagnostics, чтобы запустить Network Diagnostics.

Следуйте инструкциям на экране.

Если программа Network Diagnostics не помогла вам решить проблему, возможно, 
проблема связана с провайдером Интернет-услуг, к которому вы пытаетесь 
подключиться, с внешним устройством, которое вы используете для подключения 
к провайдеру Интернет-услуг, или с сервером, с которым вы соединяетесь. 
Попытайтесь выполнить следующие шаги.

Соединение с Интернет через кабельный модем, DSL модем или LAN
Убедитесь, что все кабели модема, включая шнур питания, кабель между модемом 
и компьютером и кабель между модемом и розеткой в стене, вставлены до упора. 
Проверьте кабели и адаптеры питания Ethernet концентраторов  
и маршрутизаторов.

Отключите на несколько минут питание вашего DSL или кабельного модема,  
и затем включите его снова. Некоторые провайдеры Интернет-услуг рекомендуют 
отсоединить шнур питания модема. Если на вашем модеме есть кнопка 
перезапуска, нажмите ее перед или после отключения питания.
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PPPoE соединения
Если вы не можете подключиться к вашему провайдеру Интернет-услуг через 
PPPoE соединение, сначала проверьте кабели и адаптеры питания,  
затем выключите и снова включите модем и перезапустите его.

Чтобы проверить системные настройки:
Выберите пункт меню Apple (K) > System Preferences.

Щелкните на вкладке Network.

Выберите пункт Network Port Configurations из выпадающего меню Show.

Перетащите пункт Built-in Ethernet наверх списка Port Configurations.

Выберите пункт Built-in Ethernet из выпадающего меню Show.

Щелкните на вкладке PPPoE.

Выберите пункт «Connect using PPPoE».

Убедитесь, что вы ввели правильную информацию в поле Account Name.

Если вы пользуетесь сохраненным паролем, введите его заново, чтобы убедиться, 
что пароль правильный.

Щелкните на вкладке TCP/IP. Убедитесь, что вы ввели правильную информацию  
в этой панели.

Нажмите кнопку Apply Now.
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Сетевые соединения
Убедитесь, что кабель Ethernet подключен к компьютеру и к сети.  
Проверьте кабели и адаптеры питания Ethernet концентраторов  
и маршрутизаторов.

Если соединение с Интернет пытаются использовать несколько компьютеров, 
убедитесь, что ваша сеть настроена правильно. Вам нужно выяснить, 
предоставляет ли ваш провайдер Интернет-услуг только один IP адрес  
или он предоставляет IP адреса каждому компьютеру.

Если предоставляется только один IP адрес, вам потребуется маршрутизатор, 
позволяющий использовать одно соединение нескольким компьютерам  
(такая функция называется NAT или ТIP маскировка). Обратитесь к документации 
вашего маршрутизатора или к человеку, который настраивал вашу сеть.  
Базовая станция AirPort Extreme Base Station позволяет использовать  
один IP адрес на нескольких компьютерах. Дополнительную информацию  
о работе с AirPort Extreme Base Station можно найти в файле справки  
или на сайте Apple AirPort по адресу www.apple.ru/airport.

Если описанные выше инструкции не помогли вам решить проблему,  
обратитесь к вашему провайдеру Интернет-услуг.
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Информация о соответствии 
коммуникационным правилам 
Заявление о соответствии 
Данное оборудование соответствует части  
15 правил FCC. Функционирование ограничивается 
следующими двумя условиями: (1) Данное 
оборудование не может вызывать вредные помехи, 
и (2) Данное оборудование подвержено любым 
помехам, включая помехи, которые могут привести 
к нежелательным последствиям.  
Обратитесь к инструкции, если есть  
подозрения о наличии помех в приеме радио  
или телевизионных сигналов.

Радио и телевизионные помехи 
Настоящее компьютерное оборудование 
генерирует, использует, а также способно излучать 
энергию на радиочастотах. Если оборудование 
установлено и используется не в строгом 
соответствии с инструкциями Apple, оно может 
вызвать помехи для радио и телесвязи.

Данное оборудование было проверено и найдено 
соответствующим установленным пределам для 
цифрового устройства класса В в соответствии  
с частью 15 правил Федеральной комиссии  
по связи (FCC). Эти пределы рассчитаны  
на адекватное предохранение от вредных помех 
в жилых помещениях. Тем не менее, отсутствие 
помех в каждом отдельном случае установки 
указанного оборудования не гарантируется.

Вы можете установить, вызывает ли ваша 
компьютерная система помехи, выключив ее.  
Если помехи прекратились, возможно, они  
были вызваны компьютером или одним  
из периферийных устройств.

Если ваша компьютерная система вызывает 
помехи для радио или телевизионного приема, 
попытайтесь устранить наводимые помехи путем 
применения следующих мер:

• Переориентируйте или переместите  
 приемную антенну.

• Поместите компьютер с другой стороны  
 телевизора или радиоприемника. 

• Увеличьте дистанцию между компьютером  
 и приемником.

• Включите оборудование в розетку, к которой  
 не подключается приемник. (То есть убедитесь,  
 что компьютер и телевизор или радиоприемник  
 подключены к участкам электрической цепи,  
 контролируемым разными автоматическими  
 выключателями или пробками.)

При необходимости, проконсультируйтесь  
с сертифицированным поставщиком услуг Apple 
или фирмой Apple. Обратитесь к информации 
о сервисе и технической поддержке, входящей 
в комплект поставки продукта Apple или 
посоветуйтесь с опытным радиотелемехаником.

Изменение и модификация данного продукта, 
не санкционированные фирмой Apple Computer 
Inc., могут привести к нарушению соответствия 
требованиям EMC и лишить вас права работы  
с продуктом.

Данный продукт был протестирован  
на соответствие требованиям EMC в условиях 
использования периферийных устройств Apple 
и экранированных кабелей и коннекторов Apple. 
Для уменьшения вероятности вызова помех  
для радио или телевизионного приема и в других 
электронных приборах нужно использовать 
периферийные устройства Apple  
и экранированные кабели и разъемы.



Использование беспроводного радио 
Поскольку данное устройство работает  
в частотном диапазоне 5,15 — 5,25 Гц, оно должно 
использоваться только внутри помещения,  
чтобы избежать возможных помех в работе 
спутниковых систем мобильной связи.

Воздействие радиоизлучения 
Уровень радиации, излучаемой AirPort Extreme, 
ниже допускаемого Федеральной комиссией 
связи США (FCC). Тем не менее, рекомендуется 
использовать беспроводное оборудование  
таким образом, чтобы человек находился  
с ним в контакте как можно меньше.

Соответствие беспроводной технологии 
Bluetooth требованиям Федеральной 
комиссией связи США 
Антенна, используемая данным передатчиком, 
не должна находиться рядом или работать 
вместе с другой антенной или передатчиком, 
соответствующим спецификациям FCC Grant.

Соответствие Bluetooth  
требованиям Канадской индустрии 
Данное устройство класса B соответствует всем 
требованиям, предъявляемым к вызывающему 
помехи оборудованию в Канаде.

Соответствие требованиям  
Канадской индустрии 
Данное устройство соответствует всем Канадским 
техническим требованиям ICES-003  
для устройств класса В.

Информация о соответствии  
Bluetooth спецификациям Europe-EU 
Данное беспроводное устройство соответствует 
спецификациям EN 300 328, EN 301-489 и EN 60950 
и положениям директивы R&TTE Directive.

Европейская декларация о соответствии 
Данное оборудование соответствует требованиям 
RF Exposure Requirement 1999/519/EC, Council 
Recommendation от 12 июля 1999 года  
по ограничению использования 
электромагнитных полей (0Гц — 300Гц.  
Данное оборудование также соответствует 
следующим стандартам: EN300 328, EN301 893, 
EN301 489-17, EN60950). 
Настоящим Apple Computer Inc. заявляет,  
что данная карта 802.11a/ b/g Mini-PCIe 
соответствует основным требованиям  
и положениям директивы Directive 1999/5/EC.

Соответствует Европейским Директивам 72/23/
EEC, 89/336/EEC, 1999/5/EC.

См. http://www.apple.com/euro/compliance/
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Информация о внешнем USB модеме 
При подключении Mac mini к телефонной  
линии с помощью внешнего USB модема 
обратитесь к информации о соответствии 
коммуникационным правилам  
в документации модема.

Соответствие стандартам ENERGY STAR 
Являясь партнером ENERGY STAR,  
Apple заявляет, что стандартные конфигурации 
данного продукта соответствуют стандартам 
ENERGY STAR по эффективному использованию 
энергии. Программа ENERGY STAR является 
результатом партнерства производителей 
офисного оборудования по обеспечению 
эффективного использования энергии. 
Уменьшение потребления энергии офисными 
продуктами экономит ресурсы и снижает  
уровень загрязнения окружающей среды.

Информация об утилизации 
Дополнительную информацию о программе 
утилизации Apple можно найти по адресу  
www.apple.com/environment/summary.html.

Информация об утилизации  
в Европейском Союзе:

 
Этот символ означает, что в соответствии 
с местными законами ваш продукт нельзя 
выбрасывать в мусоропровод. Когда продукт 
выйдет из строя, отнесите его в специальный 
пункт сбора. Некоторые пункты сбора принимают 
продукты бесплатно. Правильная утилизация 
вашего продукта поможет сохранить природные 
ресурсы и защитить здоровье людей.



Ваш Mac mini содержит встроенную батарею, 
предназначенную для сохранения настроек, 
таких, как дата и время, когда компьютер 
выключен. Не пытайтесь заменить батарею 
самостоятельно, эта процедура осуществляется 
только в сервисных центрах. 

Пульт Apple Remote содержит батарею, 
заменяемую пользователем.

Информация об утилизации батареи 
Утилизируйте батареи в соответствии с вашими 
местными законами об охране окружающей 
среды.

90



91

Числовые
802.11b/g (См. AirPort Extreme)

A
AirPort Express 50
AirPort Extreme
 антенна 23
 использование 45
 настройка соединения 82
 проблемы  
 при использовании 62
 технология 23 
 сигнал 62
Apple Remote  
(См. Пульт Apple Remote)

B
Bluetooth
 использование 47
 настройка 48
 привязка 48
 технология 23

C
CD
 запись 54

 извлечение 53
 вставка 53
Combo Drive 23

D
Dashboard 26
DHCP (См. Опции DHCP)
Dock 27
DVD
 запись 55
 извлечение 53
 вставка 53
 воспроизведение 53
DVI-VGA адаптер 15, 36
DVI-Video адаптер 36

E
Ethernet
 кабель 49
 подключение 49
 порт 49
Exposé 26

F
FireWire 
 использование 
 устройств 44 

 подключение устройств 43
 порт 25
 режим Target Disk Mode 44
Front Row 37

I
iDVD 55
IR (См. Инфракрасный порт)

M
Mac Help 27
Mac OS X
 установка 60
 информация о 26
Migration Assistant 18

N
Network Setup Assistant 79

Q
QuickTime 37

S
S/PDIF стерео 50, 51
Software Update
 настройка 30
Spotlight 26

Предметный указатель



SuperDrive 23
System Profiler 67

U
USB 13, 14, 41
 концентратор 42 
 использование  
 устройств 41
 работа с несколькими  
  устройствами 42
 подключение устройств 41
 порты 25

V
VGA 
 адаптер 25, 36
 монитор 15
 разъем 36

W
Wifi (См. AirPort Extreme)

А
адаптер
 DVI-VGA 15, 25
 DVI-Video 36
 Toslink 51
 видео 36
 питания 72
аналоговое аудио 51
аудио-устройства, 
подключение 50
аудио-вход 25, 51

Б
безопасность 69
беспроводные соединения
 AirPort Extreme 23, 45
 Bluetooth 23, 47
 доступ в Интернет и 
сети 45
 клавиатура 47
 мышь 47
 пульт ДУ 37

В
видео
 адаптер 36
 захват и 
редактирование 43
 камера 25, 43
 порт 15, 25
 устройство 36
виджеты 26
включение компьютера 16
внешние микрофоны 51
внешний модем  
USB 12, 25, 35, 41, 63, 89
выключение компьютера 19

Д
дата и время 64
двухслойные DVD 52
джойстик 41
диагностика сети 84
диск 3,5” 41

диски с программным 
обеспечением 60

З
запись
 CD 54
 DVD 55
завершение работы 
программы 33
зависание программы 33
загрузка программного 
обеспечения 30

И
игровые устройства 41
извлечение диска 63
Интернет
 подключение 18, 79
 проблемы  
 с подключением 63, 84
информация  
об утилизации 89
инфракрасный порт 23, 37
 отключение 39
использование DHCP 82

К 
кабель Toslink 51
камеры
 цифровая 41
 DV 43
клавиатура
 аналоги 14, 37 
 

92 Предметный указатель



93Предметный указатель

 беспроводная Apple 47
 настройка 14
 эргономика 77
кнопка Power 16, 25
колонки 25, 50
коммутируемое  
соединение 80

М
мини-разъем S/PDIF 50
модем
 кабельный 25, 49, 79, 82
 DSL 25, 49, 79, 82
монитор
 адаптеры 36
 подключение 36
 установка 15
мышь
 USB 14
 беспроводная Apple 47
 подключение 13
  эргономика 77

Н
настройки  
(См. Системные настройки)

О 
общая безопасность 69
обновление программ 30
операционная система 26
оптический цифровой 
аудио-вход 25, 51

оптический цифровой  
аудио-выход 25, 50
оптический дисковод 52
опции DHCP 82

П
перемещение компьютера 75
перенос файлов  
и документов 32
переустановка ПО 60
подключение
 к сети 49
 к Интернет через  
 телефон 81
 кабеля Ethernet 12 
 клавиатуры 13
 монитора 15
 мыши 13
 по локальной сети 82
 шнура питания 11
 через PPPoE 83
порт
 Ethernet 25
 FireWire 400 25, 43
 USB 13, 25, 35, 41, 42 
 аудио-вход 50
 аудио-выход 25
 видео 15, 25
 для наушников 25, 50
 оптический цифровой  
 аудио-вход 25, 51
 

 оптический цифровой 
 аудио-выход 25, 50
поставщик услуг Интернет 80
привязка
 пульта ДУ 39
 устройства Bluetooth 48 
программы
 зависание 33
 использование 33
 установка 61
 решение проблем 62
принтер и факс, настройка 29
пульт Apple Remote
 замена батареи 40
 использование 37
 кнопки 38
 общая информация 37
 отключение ИК-порта 39
 привязка 39
 удаление привязки 39
 клавиатурные  
 эквиваленты 37 

Р
рабочий стол, настройка 28
разъем для наушников 25, 50
ремонт 69, 71



C
сервис и поддержка 21
серийный номер 65
сетевые подключения 86
системные настройки 
 Bluetooth 48
 Software Update 30, 62
 загрузочный диск 59
 клавиатура и мышь 14
 предпочтения 28
 отключение FileVault 18
 отключение ИК-порта 39
 принтер и факс 29
 энергосбережение 19
сканеры 41, 43
слот безопасности 25, 56
спецификации 67
спящий режим 19

Т
трансляция музыки 50

У
уровень сигнала
 AirPort Extreme 15
 Bluetooth 15
установка
 Ethernet 12
 Mac OS X 60
 адаптера питания 11 
 

 вашего компьютера 11
 кабельного модема 82
 модема DSL 82
 обновлений ПО 30
 программ 60, 61
 принтера 29
 соединения  
 по локальной сети 82
 устройств Bluetooth
устранение проблем 57
 извлечение диска 63
 компьютер  
 не включается 59
 компьютер  
 не запускается 59
 компьютер не отвечает 58
 подключение  
 к Интернет 84
 потеря настроек даты  
 и времени 64
 с AirPort Extreme 62
 с переустановкой  
 Mac OS X 60
 с программами 62

Ц
цифровая видео камера 43

Ч
чистка Mac mini 74

Э
эргономика
 кресло 77
 монитор 75
 клавиатура 77
 мышь 77

94 Предметный указатель


